Compressed Files Menu
This menu appears if the document is a compressed file.

Uncompress Uncompress PKZip, Tar, or UUencoded files. If you have View File set in

the Compressed File Properties, KEYview will view the file. If you have
Save to Disk set, KEYview will prompt you for a filename and path to

save the document to disk.



Compressed Files Properties
Uncompress Action

View File Views the file after uncompressing it.

Save to Disk Saves the file to disk after uncompressing it.
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Converter Formats

Image/Graphics
AMI Draw Graphics (SDW) (source)
Computer Graphics Metafile (CGM)
Encapsulated PostScript (EPS)
Graphics Interchange Format (GIF)
JPEG File Interchange Format (JFIF)
Mac PICT (raster content)
MacPaint
PC PaintBrush (PCX)
Tagged Image File Format (TIFF)
Truevision Targa (TGA)
Windows Bit Map (BMP)
Windows Metafile (WMF)
WordPerfect Graphics (WPG)
WordPerfect Graphics 2.0 (WPG) (source)



Deleting Files
To delete the current document, choose Delete from the File menu. (A warning message will
appear if you have Confirm Deletions set in KEYview General Properties.)



Edit Menu

Copy Copies a selection to the clipboard. You can copy text, graphics,
images, or faxes. (If the current document is a raster image of a fax,
you can select any rectangular portion of the document.)

Find Searches for specified text in the current file. (This option is available only for
word processor, text, and spreadsheet documents.)

Find next . Searches for subsequent occurrences of the previously-specified text.
(This option is available only for word processor, text, and spreadsheet documents.)



Fax Properties
Note: To change the view, zoom, or rotation properties for a single fax page, use the
context menu from the fax page.

Scaling
Original Size Displays the fax at its actual size.
Page Width Resizes the fax to fit in the current window.
Full Page Displays a full page of the document regardless of the window size.
Custom Applies a scaling factor between 10% and 400%.
Printing
Original Size Prints the fax at its original size.
Full Page Resizes the fax to fit the full page.
Custom Scales the fax between 10% and 400% of the original size.

Horizontal Alignment

Left, Center, Right
Aligns the fax with the left, center, or right of the page.

Vertical Alignment

Top, Center, Bottom
Aligns the fax with the top, center, or bottom of the page.



File Menu

Open Opens a file for viewing.

Close Closes the current file.

Close All Closes all open files.

Launch... Launches the appropriate application for the current file.
Print... Prints the current document.

Save As... Saves the current file.

For a picture document, the Convert to pull-down list box will also contain a list
of available formats. Select the format for the converted document from this list box.
KEYview will convert the file to the selected format and then save it under the specified
name.

Delete... Deletes the current document. If you have Confirm Deletions set in the
KEYview General Properties, a warning confirmation message will appear.
Send Mail... Invokes your mail program and composes a new message with the

current document as an attachment. You may then address the message and send it from
the mail program.
Exit Exits KEYview.

In addition to the above options, this menu also lists the four most recently opened files. To
view a previously opened document, select it from this list.



Frequently Asked Questions

Question:

Question:

Question:

Question:

Question:

Question:

Question:

Question:

Question:

| integrated KEYview with the File Manager, but KEYview is not recognized.
Why not?

After you first integrate KEYview, you must restart the application for the
integration to be recognized.

Why does KEYview view Encapsulated PostScript (EPS) files but not Postscript?
KEYview does not support the viewing of Postscript files. However, you can
save a word processing document to a postscript format using KEYview. EPS
files may contain different graphic formats. KEYview does support EPS files,
as long as the graphics encapsulated are of a graphic format supported by
KEYview.

Can KEYview be used as an off-line HTML viewer?
Yes, KEYview V4.2 views documents in HTML format.

Why does an image not appear when | view an HTML document?

1) The HTML document may contain a link to the image, and since KEYview is
a viewer, not a browser, it cannot follow the links to download the image.

2) The browser may have saved the image in a temporary cache and then
have renamed the file, so KEYview cannot find it.

3) KEYview may not be able to find the image; move the image to the same
directory as the directory being viewed.

Why is there white space where there should be an image in an HTML
document?

KEYview cannot find the image. In the Word Processor Properties, disable
Display Pictures. Then the alternate text (if it is present in the document) will
be displayed If no alternate text is present, you will see "[Picture]".

How can | tell what version of KEYview | have?
To confirm this, run KEYview, and select About KEYview from the Help menu.
This will identify the version of KEYview and date of release.

When viewing a table in a word processing document using Wrap to Window
mode, how can | see the whole table?
Select Scale Tables to Fit Window in the Word Processor Properties.

| have a Word for Windows v6.0 document with both portrait and landscape
pages, but KEYview does not view it properly in page layout mode.

View these documents in Wrap to Window view mode to view both portrait
and landscape. When printed, these documents will retain their original
orientation.

What if my document has the wrong file extension ?
This is not a problem - KEYview determines the document type by looking at
the file contents, not the file extension.



General Properties
File

Confirm Deletions Brings up a confirmation dialog box whenever you delete a file from
within KEYview.

Note: If you turn this option off, the current document will be deleted
as soon as you execute the Delete command.

Multiple File Open

These options apply when you open multiple files in KEYview.

Full Window Uses the entire window to display the document.

Cascade Arranges open windows in a staggered stack so that file names are
visible.

Tile Horizontal Arranges all open windows so they fit horizontally within the KEYview
window.

Tile Vertical Arranges all open windows so they fit vertically within the KEYview

window.



Graphics Menu
This menu appears if the document is a vector graphic.

Maintain Aspect Ratio Maintains the graphic's height and width ratio. The graphic will
resize to fill the whole window but maintain its size relative to the
window.



Help Menu
Contents Displays the KEYview help contents screen.

About KEYview Displays KEYview product and version information.



Integrations
E-mail and Groupware

. FTP Software Mail OnNet

. Microsoft Mail

. Lotus cc:Mail (16-bit only)

- Lotus Notes

. HP OpenMail

. Microsoft Windows File Manager
. Other popular mail systems

World Wide Web Browsers

. FTP Software Enhanced Mosaic
. Netscape

. Other popular Web browsers
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Whats available with the KEYview 4.2 Upgrade

The full KEYview 4.2 product comes with a number of additional viewing formats, integration
options, and document conversion capability. It installs right over top of the version of
KEYview which comes with the FTP Software TCP/IP suite.

For more information, please contact the technical support organization appropriate for you.

Depending upon your product purchase, the technical support organization appropriate for
you might be:

FTP Software Technical Support.
Another supplier of FTP Software products.
Your organization's Help Desk or System Administrator.

Upgrade Viewer Formats

Upgrade Converter Formats
Upgrade Integrations




KEYview Formats

Viewer Formats
Converter Formats

Integrations



Launching Other Applications from KEYview

When you view a file with KEYview, you can launch other applications for editing and

revising the file.

To launch an application, click the Launch button on KEYview toolbar, or select Launch...

from KEYview File menu.

File Information

Launch Application

Options

This brings up the Launch Manager window.

This box displays the information about the current file. It
lists the name, format, size (in bytes), and last modification
date of the file.

This box lists the applications that can be selected for
launching. The first application in this list,
WindowsDefaultAction, launches the file based on the
Windows file extension associations. You can use the
Browse button to add more applications to this list. Select
the desired application, then click Launch or press RETURN.

Remember Selected Action To have KEYview remember this selection for all future

files of this type, set this checkbox. The Launch Manager
window will then not appear again for files of this type
unless you reset the launch preferences.

Use KEYview Conversions This option is available only if a conversion exists for the

selected Launch Application. When you select this option,
KEYview will first convert the file to the format of the
highlighted application and then launch the application.

Note: This option will only be available if you have
upgraded to the full KEYview product.



Managing Files
Deleting Files
Saving/Converting Documents



Menus and Buttons

This section describes the menu commands, and their associated buttons on KEYview
toolbar. (Some commands are not available for all document types; for example, Find text
is not applicable when viewing graphics.)

Note: Many of these commands are also available via the context menu (obtained by
clicking the right mouse button on the KEYview window).

Note: You can also set many of these via KEYview Properties.

File Menu

Edit Menu

Word Processor Menu
Spreadsheet Menu
Picture/Fax Menu

Graphics Menu

Presentation Graphics Menu
Compressed Files Menu
Options Menu

Window Menu

Help Menu




New Features of KEYview Version 4.2
View and Print Headers and Footers

KEYview now allows you to view and print headers and footers in word processing
documents.

OLE 2.0 Compliant

You can now drag-and-drop content from KEYview onto any OLE 2.0-compliant target
application (for example, Microsoft Word 6.0).

Partial Fax/Picture Selection

When viewing any raster graphic format, or fax formats, you may now select a rectangular
portion of the picture or fax. This partial selection can then be copied to the clipboard,
printed, or drag-and dropped onto another application.

File Manipulation
KEYview now lets you delete or mail (using MAPI) the current document.

Multiple File Open
The File/Open dialog now allows you to select and open multiple files at once.

Acrobat Aware

When an Adobe Acrobat (PDF) file is opened in KEYview, KEYview will pop up a dialog
allowing you to view the document as text, launch the Adobe reader, or save the file to disk.

HTML Viewing

An HTML speed reader is now included in KEYview 4.2. This provides a formatted view of
HTML documents, letting you see how a web browser would view the document. (Links are
shown but are not active.)

Compressed Format Saving

You can now use the Save As functionality of KEYview to save the current document in
compressed format: tar, UUencode, Z-compression, or BinHex.

Compressed Format Viewing

KEYview can now view files encoded in the following compression schemes; BinHex, Tar,
UUencode, Z-compression, GZ-compression and PKZip.

Common Print Dialog Box

All printing is now done through common print dialog box. You can now alter your printer
selection and options through this dialog. (The document is not affected by these settings.)

Spreadsheet Viewer Improvements

KEYview spreadsheet viewing engine has been re-written, providing faster and more
accurate viewing.

Improved Picture Viewer
The picture viewing capability of KEYview is now much faster.



Notes on Opening Compressed and Encoded Files
Z, GZ, and BinHex Files

When you open a file of these types, KEYview automatically decodes and views the file for
you. (KEYview decodes the default GZ compression scheme; it will not decode some GZ
files which use different options.)

PKZip, Tar, and UUencoded Files

When you open a file of these types, KEYview displays a list of file(s) included inside. The
list also displays the name, size and last modification date for each file.

To extract a file from the list, double-click the file, or select the file and press Enter, or chose
Uncompress from the Compressed Files menu, or click the Uncompress button. KEYview will
decompress the file. If you have View File set in the Compressed File Properties, KEYview will
view the file. If you have Save to Disk set, KEYview will prompt you for a filename and path
to save the document to disk.



Notes on Viewing Spreadsheets
KEYview allows you to view Lotus 1-2-3 and Microsoft Excel spreadsheets.

Viewing Size
KEYview displays the spreadsheet up to one cell past the largest address of the
spreadsheet. For example, if the last cell of the spreadsheet is column G and row 20,
KEYview will display up to column H and row 21. KEYview does not display blank cells
outside this area. You may have to scroll left, right, up and down to view the complete
spreadsheet. If text extends beyond the last column of the KEYview display, it may not
be visible. To view the entire text, you can increase the size of the column and then
scroll left or right.

Cell Contents
KEYview displays the values of cells rather than cell contents. For example, if a cell
contains a formula, KEYview will display the result of that formula and not the formula
itself.

Colors

KEYview will display the colored and shaded cells along with borders for Excel
spreadsheets. It cannot display colors for Lotus 1-2-3 spreadsheets as Lotus 1-2-3
stores this information in a separate file that KEYview cannot access.

Fonts and Font Sizes

KEYview displays the fonts and font sizes for Excel documents. Lotus 1-2-3
spreadsheets will be displayed in Courier 12 point as Lotus stores font information in a
separate file that KEYview cannot access.



Opening and Viewing Files
To view a document from KEYview:

1. Click the Open button on the KEYview toolbar, or select Open from KEYview File
menu.

2. Select the desired file(s) and click Open or press Enter.
If the file is a format which can be viewed by KEYview and you have the viewer for
that format installed, the file will be displayed in the KEYview window.

If the file is a format which KEYview does not support, KEYview will display a pop-up
dialog box. You may choose:

Launch allows you to choose an application capable of viewing that file format.
(To guard you from running an executable file unexpectedly, this option
will be disabled if the file is an executable.) For more information, see
Launching Other Applications from KEYview.

Save to Disk saves the file to disk.
View as Text views the file as a text file.
Cancel does nothing with the file.

(See Viewer Formats for a list of viewer formats supported by KEYview.)

Note: You can also view files in KEYview by using the Windows drag-and-drop method.
(See Selecting Content for details.)



Options Meu

Properties =T Specifies preferences. (See Properties.)
Toolbar Shows or hides the KEYview toolbar.
Launch... Brings up a dialog allowing you to clear all selected actions for the

Launch command.



Overview

The KEYview 4.2 components selected to be integrated with this TCP/IP suite from FTP
Software were chosen to maximize the majority of customer requirements for document
viewing without including the entire KEYview product.

If you would like further information on what the full KEYview 4.2 product could provide for
you, please see Whats available with the KEYview 4.2 Upgrade.

Use KEYview to:

. Instantly view almost any file you receive electronically, even if you don't have the
application that created it. With KEYview you can open:

. text and word processor documents

. spreadsheets

. raster images and vector graphics

. e-mail attachments

. faxes

. HTML (World Wide Web) documents

. compressed files (BinHex, Tar, UUencoded, Z, GZ, and PKZip formats).
. Open groups of files in multiple formats quickly and easily.

] Open files with incorrect or missing extensions.

. Open a document, then:

. search for text in it

] copy content from it

. launch another application to revise it

. print it

] compress it

. mail it.



Picture Properties
Raster Images

Original Size
Whole Picture

Custom

Vector Graphics

Maintain Aspect Ratio

Raster Image Printing
Original Size
Full Page

Custom

Horizontal Alignment
Left, Center, Right
Vertical Alignment

Top, Center, Bottom

Displays the image at its actual size.
Resizes the image to fit in the current window.

Scales the graphic between 10% and 400% of the original
picture size.

Maintain the graphics height and width ratio. The graphic will
resize with the window but maintains its size relative to the
window. If you turn this option off, the graphic will resize to fill
the window regardless of the height/width ratio.

Prints the image at its original size.

Resizes the image to fit the full page.

Scales the graphic between 10% and 400% of the original
picture size.

Aligns the image with the left, center, or right of the page.

Aligns the image with the top, center, or bottom of the page.



Picture/Fax Menu
This menu appears if the file is a raster image or a fax document.

Rotate @ Rotates the displayed image clockwise. (The button rotates the
image 90 degrees. The menu provides choices of 0, 90, 180, or
270 degrees rotation from the original orientation.)

Magnify
Full Picture Displays the full picture regardless of the window size.
Original Size 100 View the picture at its original size.
Custom Applies a scaling factor between 10% and 400%.
Invert @ Inverts black and white images.

Context Menu for Pictures
Additional options for pictures are available via the context menu:

Aspect Ratio
based on document Uses the document's aspect ratio.

use scanlines Uses the number of pixels and the number of scanlines to
determine the aspect ratio.

times 2 Uses a 2:1 aspect ratio.

Context menus for Fax documents

There are two context menus available for a fax document. These allow you to control
settings for a single page or the entire document.

a) Context menu for a singe page
Additional options available via this context menu:

Copy Page to Clipboard
Copies the whole page to the clipboard.

Print Page Prints the whole page.

Aspect Ratio Selects the width-to-height ratio.

b) Context menu for the entire fax document

To select this menu, place the mouse pointer on the gray area of the KEYview window
and then click the right mouse button.



Presentation Graphics Menu
This menu appears if the document is a PowerPoint file.

Run PowerPoint Viewer @ Views PowerPoint documents if the PowerPoint viewer is
available to KEYview (either through the Windows program
registry or in the KEYview directory).



Printing

To print the current file, choose Print from the File menu.

If a partial selection of a raster graphic or fax document is currently selected, you may print
only this section by checking the Selection option in the print dialog box. Then only the
image contained within the selected area will be printed.



Properties

KEYview Properties allow you to modify all viewing preferences for the current and
subsequent files.

To display the properties dialog box, click the properties button = from KEYview toolbar, or
select Properties... from KEYview Options menu or from a context menu.

Note: To save the settings so they affect future documents, leave the Save on Exit checkbox
checked. Otherwise, they affect only the current document.

Clicking on Defaults resets the options to their default values.

General Properties
Word Processor Properties

Text File Properties
Spreadsheet Properties
Picture Properties
Compressed File Properties
Fax Properties




Reference
Menus and Buttons

Properties



Resetting Document Associations for Launching
To reset associations for launching documents, select Launch... from KEYview Options menu.

In the dialog box that appears, click Clear Selected Actions to clear all associations, or click
Close to cancel the operation.



Saving/Converting Documents
KEYview allows you to save the current file in a different location or with a different name.
(A graphics file can also be saved in a different format.)

1. Display the document as described in Opening and Viewing Files.

2. Click the Save As button = of the KEYview toolbar, or select Save As from the File menu.
KEYview will display the Select target filename window.

Select the drive and directory and enter the name for the converted document.
If applicable, select the format you wish to convert to from the Convert to list.
Click OK or press Enter.

vk Ww



Searching for Text
KEYview allows you to search text in text, word processor or spreadsheet documents.
(KEYview will search the body text; it will not search headers and footers.)

1. Display the document as described in Opening and Viewing Files.

2. Click the Find button = of the KEYview toolbar, or select Find from KEYview Edit menu.

KEYview will display the Find dialog box.
3. Enter the text to be searched in the Find What box.

To limit search to the exact text including upper and lower case, check the Match
Case button.

4, Select the Up or Down button to start searching upwards or downwards from the
current location.

5. Click Find Next or press Enter. KEYview will highlight the next occurrence of the
specified text.

6. Click Cancel to close the Find box.

7. To search for subsequent occurrences of the same text, click the Find Next button =,

or use the Find Next option in KEYview Edit menu, or press F3.



Selecting Content

With word processing and text documents, KEYview allows you to select formatted content,
including pictures, tables, paragraph properties, and character properties. For fax and
raster graphics documents, you may select the whole picture or just a portion of it. Once
you have selected some content, you may:

. copy the selection to the clipboard,
- drag the selection to an OLE 2.0 compliant target application (e.g., Microsoft Word
6.0).

For fax and raster graphics partial-picture selections, you may also print just the selection by
checking the Selection option in the print dialog box.

Using Drag-and-Drop to Open Files in KEYview
To open files in KEYview by using the Windows drag-and-drop method:

1. In the File Manager, select the files to be viewed.
2. Drag the files onto the KEYview window or minimized icon of KEYview.

The selected files will be displayed on your screen in the order they were selected.

Dragging Content from KEYview Into Other Applications

You can also drag-and-drop content from KEYview onto any OLE 2.0-compliant target
application (for example, Microsoft Word 6.0). The cursor will change to an arrow indicating
that content is ready to drag-and-drop when it is:

within the selected content in a word processing document

at the boundary of the selection in spreadsheets

within the selected region of raster graphics or fax documents
over top of a vector graphic.



Spreadsheet Menu
This menu appears if the document is a spreadsheet.

Previous Spreadsheet Displays the previous spreadsheet from a spreadsheet
workbook.

Next Spreadsheet Displays the next spreadsheet from a spreadsheet workbook.
Context Menu
An additional command is available via the context menu:

Toggle Gridlines Toggles gridlines on or off.



Spreadsheet Properties

Gridlines
On, Off Toggles viewing gridlines in the displayed document.

Base on Spreadsheet
Displays or ignores gridlines depending on the setting used in the
original document.

Headings
On, Off Toggles viewing headings in the displayed document

Base on Spreadsheet
Views headings depending on the setting used in the original
document.

View Graphic Objects

On Shows any graphic objects embedded in the document.



Starting KEYview

KEYview can be started:
a) as a stand-alone application, or

b) from within the FTP Software TCP/IP suite.



Text File Properties
Page Margins

Left, Right, Sets the margins between Omm and 100mm.
Top, Bottom
Font
Change Changes the font name and size used for displaying the document.

Character Set

ANSI Uses the ANSI character set for displaying the document. This is the
Microsoft Windows default.

OEM Uses the OEM character set for displaying the document. This is
useful when the text file was created with characters from the DOS
code page currently in effect.

Page Layout

Portrait Displays the document in portrait mode (tall and narrow).
Landscape Displays the document in landscape mode (short and wide).
Characters

Filter Non-printable Filters out any non-printable characters.



The KEYview Guide
You can view and print the KEYview guide (KVMANUAL.DOC) by using KEYview, or by using

Word for Windows v2.0 (or later).

The guide details items specific to KEYview. For general information on using Windows,
please consult your Windows documentation or use the Windows help facility.



Troubleshooting

To resolve problems with this product, please contact your supplier.

Frequently Asked Questions



Upgrade Converter Formats

Note: The following is the complete list of KEYview converter formats, including some that
you already received with the FTP Software TCP/IP suite.

Text/Word Processor
ASCII Text
Applix Asterix
Clig Word
DECdx
DEC WPS-PLUS Native
HP Word/PC
HTML (target)
IBM 1403 Line Printer
IBM DCA-FFT
IBM DCA-RFT
IBM DCF Script
IBM DisplayWrite
Lotus AMI Professional
MASS-11
Microsoft Rich Text Format
Microsoft Word for Mac
Microsoft Word for PC
Microsoft Word for Windows 2.x, 6.x
Microsoft Word for Windows 95
MultiMate Advantage, Advantage Il
Navy DIF
ODA FOD 26
Office Writer
PostScript Writer (target)
Quadratron Q-One
Siemens-Nixdorf Targon Word
Uniplex Il Plus
Wang OIS/VS Comm Format
Wang WITA
WordMARC
WordPerfect 5.x
WordPerfect 6.x (source)
WordStar

Image/Graphics
AMI Draw Graphics (SDW) (source)
Computer Graphics Metafile (CGM)
Encapsulated PostScript (EPS)
Graphics Interchange Format (GIF)
JPEG File Interchange Format (JFIF)
Mac PICT (raster content)
MacPaint
ODA G3 Format
ODA G4 Format
ODA Raw Bitmap Format
PC PaintBrush (PCX)
Tagged Image File Format (TIFF)



Truevision Targa (TGA)

Windows Bit Map (BMP)

Windows Metafile (WMF)

WordPerfect Graphics (WPG)
WordPerfect Graphics 2.0 (WPG) (source)
CCITT Group 3



Upgrade Integrations

Note: The following is the complete list of KEYview integrations, including some that you
already received with the FTP Software TCP/IP suite.

E-mail and Groupware
FTP Software Mail OnNet
Microsoft Mail
Lotus cc:Mail (16-bit only)
Lotus Notes
HP OpenMail
Microsoft Windows File Manager
Other popular mail systems

World Wide Web Browsers

FTP Software Enhanced Mosaic
Netscape
Other popular Web browsers



Upgrade Viewer Formats

Note: The following is the complete list of KEYview viewer formats, including some that you
already received with the FTP Software TCP/IP suite.

Text/Word Processor
Adobe Acrobat PDF
ASCII Text
Applix Asterix
Clig Word
DECdx
DEC WPS Plus Native
HP Word/PC
HTML
IBM 1403 Line Printer
IBM DCA-FFT
IBM DCA-RFT
IBM DisplayWrite
IBM DCF Script
Lotus AMI Professional
MASS-11
Microsoft Rich Text Format
Microsoft Word for Mac
Microsoft Word for PC
Microsoft Word for Windows 2.x, 6.x
Microsoft Word for Windows 95
MultiMate Advantage, Advantage Il
Navy DIF
ODA FOD 26
Office Writer
Quadratron Q-One
Siemens-Nixdorf Targon Word
Uniplex Il Plus
Wang OIS/VS Comm Format
Wang WITA
WordMARC
WordPerfect 5.x, 6.x
WordStar

Spreadsheet
Lotus 1-2-3
Microsoft Excel 3.x, 4.x, 5.x

Image/Graphics
AMI Draw Graphics (SDW)
Computer Graphics Metafile (CGM)
Encapsulated PostScript (EPS)
Graphics Interchange Format (GIF)
JPEG File Interchange Format (JFIF)
Mac PICT (raster content)
MacPaint
ODA G3 Format



ODA G4 Format

ODA Raw Bitmap Format

PC PaintBrush (PCX)

Tagged Image File Format (TIFF)
Truevision Targa (TGA)

Windows Bit Map (BMP)
Windows Metafile (WMF)
WordPerfect Graphics (WPG)
WordPerfect Graphics 2.0 (WPG)
CCITT Group 3

Fax
DCX
TIFF

Other

PKZip
Z-compression
GZ-compression
UUencode

TAR

BinHex



Using KEYview

Starting KEYview

Opening and Viewing Files

Selecting Content

Searching for Text

Printing

Managing Files

Launching Other Applications from KEYview




Viewer Formats

Text/Word Processor
ASCII Text
HTML
Lotus AMI Professional
Microsoft Rich Text Format
Microsoft Word for Windows 2.x, 6.x
Microsoft Word for Windows 95
WordPerfect 5.x, 6.x

Spreadsheet
Lotus 1-2-3
Microsoft Excel 3.x, 4.x, 5.x

Image/Graphics
AMI Draw Graphics (SDW)
Computer Graphics Metafile (CGM)
Encapsulated PostScript (EPS)
Graphics Interchange Format (GIF)
JPEG File Interchange Format (JFIF)
Mac PICT (raster content)
MacPaint
PC PaintBrush (PCX)
Tagged Image File Format (TIFF)
Truevision Targa (TGA)
Windows Bit Map (BMP)
Windows Metafile (WMF)
WordPerfect Graphics (WPG)
WordPerfect Graphics 2.0 (WPG)

Fax
DCX
TIFF

Other
PKZip
Z-compression
GZ-compression
UUencode
TAR
BinHex



Window Menu

Cascade Arranges open windows in a staggered stack so that file names are visible.

Tile Horizontal Arranges all open windows so they fit horizontally within the KEYview
window.

Tile Vertical Arranges all open windows so they fit vertically within the KEYview
window.

Arrange Icons Reduces files to icons at the bottom of the KEYview window.

In addition to the above options, this menu also lists open files in the order they were
opened.



Word Processor Properties
View Mode

Wrap to Window Wraps all text to fit the screen. This makes it easy to scroll
through wider documents.

Scale Tables to Fit Window
Also scales any table to fit the window.

Page Layout Displays the document as it would print.

Process Headers and Footers
Shows headers and footers (if they are present in the
document).

Process Multi-columns
Shows multiple columns (if they are present in the document).

Zoom
100% Displays the document at its actual size.
Page Width Resizes the page to fit the current window.
Custom Applies a scaling factor between 10% and 200%.
Pictures
Display Pictures Views any embedded or linked pictures in the document. For

faster viewing of complex documents on slow machines turn
this option off. Then only the formatted text will be displayed;
all pictures will be ignored.



Word Processor Menu
This menu appears if the document is a text or word processor document.

Wrap to Window Views documents in wrap to window mode. Text will be
reformatted, where possible, to fit the current window width.

Page Layout Displays documents in print preview mode. All formatting will be
retained.









